HOWTO: Install CodeWarrior 11.1 Updates/
Updates for DSC + devices support

This is a document to detail the steps to install CodeWarrior 11.1 and the associated updates for MC56F83xxx

support.
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If you haven't installed CodeWarrior 11.1 OR you've installed CodeWarrior 11.1 by offline installation method
but didn’t install Updates and Service Pack for required devices, follow the instructions in Downloads section
before proceeding to the Installation section.

Please note that MC56F83xxx device support depends on DSC compiler update which is included into update.
If only compiler update is required — please follow instructions in Install DSC compiler update only

1. Downloads

Download the install files for CodeWarrior 11.1 and Update 3

1. Go to www.nxp.com/mcull or www.nxp.com/DSC (then locate the CodeWarrior link under DSC
Software section) .
2. Click on the Downloads tab



http://www.nxp.com/mcu11
http://www.nxp.com/DSC
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}%{ Products  Applications Support ~ Company

AMyNXP @ENY =

& Software > Development Software > CodeWarrior Development Tools > CodeWarrior Legacy > CodeWarrior for MCU 11.1

CodeWarrior® for MCUs (Eclipse IDE) - ColdFire®, 56800/E DSC, ® <
Qorivva® 56xx, R508/508,5127 - 11.1

OVERVIEW DOCU DOWNLOADS DEVELOPMENT TOOLS BUY/PARAMETRICS TRAINING & SUPPORT
Jump;To Overview Features
OVEIView & Featircs) Our CodeWarrior® for Microcontrollers v11.0 integrates Eclipse IDE 4.2.1 (Juno) and CDT 8.1.1
Supported Devices the development tools for the ColdFire®, ColdFire+ T ——
Target Applications DSC, Kinetis®, MPC5xxx, RS08, S08 and S12Z o

architectures into a single product based on the Eclipse C/C++Icomp|ler and debugger (restrictions based

System Requirements & Support Policy open development platform. The modular installer on suite)
Get Started provided with the tools, however, allows you to select Integrated flash programmer

and install only the architecture support you need for Eull-chip simulation for DSC. RS08 and S08

More >

C Perspective

3. Click on the large Download button next to CodeWarrior® for MCUs (Eclipse IDE) - CoIdFire®,
56800/E DSC, Qorivva® 56xx, RS08/S08, S12Z - 11.1.

N

Va4 Products  Applications Support  Company Qs x My NXP GEN. =

& Software > Development Software > CodeWarrior Development Tools > CodeWarrior Legacy > CodeWarrior for MCU 11.1

CodeWarrior® for MCUs (Eclipse IDE) - ColdFire®, 56800/E DSC, ® <
Qorivva® 56xx, R508/508,5127 - 11.1

OVERVIEW DOCUMENTATION DOWNLOADS DEVELOPMENT TOOLS BUY/PARAMETRICS TRAINING & SUPPORT

Product Downloads CodeWarrior® for MCUs (Eclipse IDE) - ColdFire®,

56800/E DSC, Qorivva® 56xx, RS08/508,512Z - 11.1
Latest Version

Previous Version
Updates & Patches

Existing and New licenses

Filter By| Show All Updates and Patches (3)

Q CodeWarrior for MCU 11.1 Update 1(REV UP1)
This update includes service pack support for the 56F83xxx devices, updated version of DSC
compiler, updated version of $12Z compiler. The update is intended to be installed on top of CW

Updates and Patches (2 Meu vttt

Development Software (2

© FLEXERA 1KE MCU_11_1_UP1 2019-11-10 11:49:00

” . i (RE!
0 ::;)SeWarnor for MCU 11.1 - Service Pack for S08PB and S08PLSREV

This service pack update support for the S08PBS, S08PB16, S08PLES, S08PL16S

microcontrollers. The service pack is intended to be installed on top of CW MCU v11.1
®
®

n CodeWarrior for MCU 11.1 - Service Pack for SOBPL60REV 1.0.4)
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8. At this point, you may be asked to sign in or register with NXP.com. Once you complete sign-in,
registration or if you are already signed in, you will be presented with the Product Information page. Click
on the link for CodeWarrior for MCU Professional Edition

}\f{ Products ~ Applications ~ Design ~ Support ~ Company Q search nxp.com

NXP > Software & Support * Product Information : CodeWarrior Development Tool - Evaluation Software

Software & Support :
= Product Information
Product List
Froduct Seach CodeWarrior Development Tool - Evaluation Software
Order History
Recent Product Releases
Recent Updates To register a New Product please click on the button below
e Register]
License Lists

Offine Activation Current | Previous

FAQ Version Description
Download Help "1

CodeWarri ) Professional Edition

Table of Contents
FAQs

ABOUT NXP RESOURCES FOLLOW US

TermsofUse = Terms of Sale  Slavery and Human Trafficking Statement  Feedback

9. The Software Terms and Conditions are presented for your review and agreement. Click | Agree.

Products  Applications  Design  Support  Company Q

NXP > Software & Support * Software Terms and Conditions

Scitware & Support Software Terms and Conditions
Product List
Product Search CodeWarrior for MCU Professional Edition (Windows - Eclipse) Evaluation / Updates

Order History
Recent Product Releases Please read the following agreement and click "| AGREE" at the bottom before downloading your software.

Recent Updates

N . LA_OPT42 v7 January 2019 2
Licensing
License Lists
Offline Activation IMPORTANT. Read the following NXP Software License Agreement (“Agreement’) completely. By selecting the “I Accept” button at
the end of this page, or by downloading, installing, or using the Software, you indicate that you accept the terms of the Agreement
FAQ and you acknowledge that you have the authority, for yourself or on behalf of your company, to bind your company to these terms
Download Help You may then download or install the file. In the event of a conflict between the terms of this Agreement and any license
terms and ti for NXP's prop: y software embedded here in the Software file, the terms of this Agreement
el o Contents shall control. If a separate license agreement for the Software has been signed by you and NXP, then that agreement
FAGs shall govem your use of the Software and shall supersede this Agreement

NXP SOFTWARE LICENSE AGREEMENT

This is a legal agreement between your employer, of which you are an authorized representative, or, if you have no employer, you
as an individual (*you” or “Licensee”), and NXP B.V. ("NXP7). It concerns your rights to use the software provided to you in binary or
source code form and any accompanying written materials (the “Software"). The Software may include any updates or error
corrections or documentation relating to the Software provided to you by NXP under this Agreement. In consideration for NXP

Cancel

=

10.The Product Download page is presented, with all of the available files for download. The files required
to be downloaded for each installation method is listed in the table below:
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File Description

CodeWarrior for MCU 11.1 Update 3

CodeWarrior for MCU 11.1 - Offline

CodeWarrior for MCU 11.1 - Online

File Name

Product Download

CW_MCU_v11.1_b181224 PE.exe

Installation
Method

CW_MCU_11_1_Update3_200717.zip

Offline

CW_MCU_v11.1_b181224 PE_Offline.exe

Online

Additional Notes

Only required for offline installations

Only required if not already installed

Only required if not already installed. Online means
that PC is connected to Internet and installation
would be able to contact CodeWarrior Update site

CodeWarrior for MCU Professional Edition (Windows - Eclipse) Evaluation / Updates

Files License Keys Motes

© Download Help

22 Fes
+  File Description S FileSize ¥ File Name =
<+ CodeWarrior for MCU 11.1 - Release Notes 668.6 KB # CW_MCU_v11_1_RN.pdf
=+ Codewarrior for MCU 11.1 Service Pack for DSC 11.6 MB & com.freescale.mcuti1_1.DSC_MC56F826xx win.sp.v1.0.16.zip

MC56F82x0x with PEX
<+ CodeWarrior for MCU 11.1 Update 1 67.8MB & CW_MCU_11_1_Update1_191113.zip
<+ CodeWarrior for MCU 11.1 Update 2 68 MB & CW_MCU_11_1_Update2_200211.zip
+ Codewarrior for MCU 11.1 Update 3 147.7 MB & CW_MCU_11_1_Update3 200717 zip Ofﬂ | ne
4+ CodeWarrior for MCU v11.1 - Offline 1.7GB & CW_MCU_v11.1_b181224_PE_Offline.exe
<+ CodeWarrior for MCU v11.1 - Online 5136 MB & CW_MCU_v11.1_b181224 PE exe <1:| on | ine
<+ CodeWarrior MCU 11.1 Service Pack for MWCT1011B 25MB & com.freescale.mcu1i_1.DSC_MWCT1011B.win.sp.v1.0.2.zip
<+ CodeWarrior MCU 11.1 Service Pack for S08PB and 3.4MB & com.freescale.mcuil1_1.HCS08_PB16.win.sp.v1.0.8.zip
S08PLS
<+ com.freescale.mcu11_1.coldfire.updatesite 254.3MB & com.freescale.mcu11_1.coldfire.updatesite.zip
<+ com.freescale.mcu11_1.dsc.updatesite 199.7 MB & com.freescale.mcui1_1.dsc.updatesite.zip
+ com.freescale. mcu11_1.e200.updatesite 111.1 MB & com.freescale.mcu11_1.e200.updatesite.zip
+ com.freescale.mcu11_1.hcs08_rs08.updatesite 196.6 MB & com.freescale.mcui1_1.hcs08_rs08.updatesite.zip
=+ com.freescale.mcut1_1.kinetis.updatesite 458.9 MB # com.freescale.mcut1_1 kinetis.updatesite zip
4+ com.freescale.mcut1_1.s12z updatesite 1221 MB & com.freescale.mcuil_1.s12z updatesite zip
4+ CW MCU 11.1 Service Pack for DSC MC56F8 1300 9.8 MB & com.freescale.mcu11_1.DSC_MC56F81xxx.win.sp.v1.0.17.zip
4+ CW MCU 11.1 Service Pack for FXTH870000 28MB & com.freescale.mcull_1.HCS08_FXTH870000.win.sp.v1.0.6.zip
4 CW MCU 11.1 Service Pack for FXTHB870000 Library 28MB & com.freescale.mculi_1.HCS08_FXTH870000_LIB.win.sp.v1.0.4.zip
4 CW MCU 11.1 Service Pack for MWCT2xx3 5MB & com.freescale.mcuti_1.DSC_MWCT2xx3.win.sp.v1.0.8.zip
4+ CW MCU 11.1 Service Pack for NTIM88 Library 28MB # com.freescale.mcull_1.HCS08 NTM88_LIB.win.sp.v1.0.2.zip
+ CwW_MCU_v11_1_3 Release_Notes 2306 KB # CW_MCU_v11_1_3_ Release_Motes.pdf
<+ Service Pack for S08PL60 3.5MB & com.freescale.mcut1_1.HCS08_PL60.win.sp.v1.0.4.zip
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Service Pack and Patches

At the moment of this document creation latest update is Update 3, if newer update would be available
—the same procedure should be followed, considering that updates are cumulative and user need to
install only last update.

The following table lists files required to install Service Pack support for devices for offline installation.
Please download those you need and keep them ready for installation.

CodeWarrior for MCU 11.1 Service Pack for DSC com.freescale.mcull_1.DSC_MC56F826xx.win.sp.v1.0.16.zip
MC56F82xx with PEX

CodeWarrior MCU 11.1 Service Pack for MWCT1011B com.freescale.mcull_1.DSC_MWCT1011B.win.sp.v1.0.2.zip

CodeWarrior MCU 11.1 Service Pack for SO8PB and com.freescale.mcull_1.HCS08 PB16.win.sp.v1.0.8.zip
SO08PLS

CW MCU 11.1 Service Pack for DSC MC56F81xxx com.freescale.mcull_1.DSC_MC56F81xxx.win.sp.v1.0.17.zip
CW MCU 11.1 Service Pack for FXTH870000 com.freescale.mcull_1.HCS08 FXTH870000.win.sp.v1.0.6.zip

CW MCU 11.1 Service Pack for FXTH870000 Library com.freescale.mcull_1.HCS08 FXTH870000_LIB.win.sp.v1.0.4.zip

CW MCU 11.1 Service Pack for MWCT2xx3 com.freescale.mcull_1.DSC_MWCT2xx3.win.sp.v1.0.8.zip
CW MCU 11.1 Service Pack for NTM88 Library com.freescale.mcull_1.HCS08 NTM88 LIB.win.sp.v1.0.2.zip
Service Pack for SO8PL60 com.freescale.mcull_1.HCS08_ PL60.win.sp.v1.0.4.zip



https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
https://nxp.flexnetoperations.com/control/frse/download?agree=Accept&element=10623377
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2. Installation
From here on, select one method from the following:
e Offline installation

« Offline Install CodeWarrior v11.1 + Update 3
« Offline Install Update 3 (with CodeWarrior v11.1 already installed) — skip to step 2 in offline
installation section
+ Offline install of Service Packs for devices
*  Online installation

* Online Install CodeWarrior v11.1 + Update 3 — go to Online Install CodeWarrior v11.1 + Update 3
* Online Install Update 3 (with CodeWarrior v11.1 already installed) - go to step 3 in online installation
section
+ Install DSC compiler update only (with CodeWarrior v11.1 already installed) — go to instructions
Please note that it is possible to use offline method for base tools installation and later use online method
for Updates and Service packs, and vice versa.

Offline Install CodeWarrior v11.1 + Update 3

1.Execute the offline installer (CW_MCU_v11.1_b181224 PE_Offline.exe), following the prompts along
the way. Be sure to select DSC on the Choose Components menu.

= CodeWarrior Development Studio for Microcontrollers v11,1 5., — X

Choose Components -
Choose which features of CodeWarrior Development Studio for Microcontrollers w11.1 == #*
you want to install. -

Check the components you want to install and uncheck the components you don't want to
install. Click Mext to continue.

Select components to install; [] ColdFiresensars
|:| Kinetis

D Qorivva
Os12z

[ sos/rsos

Description

Space required: 1.5GB
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2. When complete, launch CodeWarrior v11.1, then go to Help -> Install New Software...

++ - CodeWarrior Development Studio -
C/C CodeWarrior Develop Studi O x
File Edit Source Refactor Search Project MOX Tools ProcessorExgpert Run  Window Help
= A [Active) ~ ﬁ ﬁ hd FTryw 4 v Welcome
(7} Help Contents ﬁl g i+
7 Search —
E@ CodeWarrior Projects 52 = 0 % - he =]
namic Help
az‘ = 4:5‘9 File Name
- Key Assist... Ctrl+Shift+L
” Videos...
File Name Build eos
Tips and Tricks...
Cheat Sheets...
Check for Updates
| Install Mew Software...
Documentation
About CodeWarrior Development Studic
£ Commander £3 = T =g
+ Project Creation - Se
£y Import project @*
% Import example project o
£y Import MCU executable file %’
% MNew MCU project - Mi
= Build/Debug \
LY & O[3l problems 2 e H Y=0
g ;’3 F Diterns
Description Resource Path Location Type
Updates Available x|
| Updates are available for your software. |
@ 5 | Click to review and install updates. |
| Set up Reminder options |
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3. From the Install menu, select Add...

¥ Install

Available Software

Select a site or enter the location of a site. » ]

Work with:e type or select a site|

v Add...

Find more software by working with the "Available Software Sites” preferences.

type filter text

Name Version
[J@ Thereis no site selected.

Select All Deselect All

Details

Show only the latest versions of available software [[] Hide items that are already installed

Group items by category What is already installed?
[ Show only software applicable to target environment

Contact all update sites during install to find required software

@

< Back Next > Finish Cancel
I
4. Select Archive...
¥ Add Repository X
Name: l Local...
Location: | http:// Archive...
@ 0K Cancel

5. Navigate to the update file downloaded (CW_MCU_11_ 1 Update3_200717.zip), select it and click Open

6. Click OK in Add Repository dialog
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7. Notice the Updates listed in the Install menu. Check the boxes for 'MCU v11.1 Updates' and 'MCU v11.1
Updates for DSC'. These updates are cumulative, so all previous updates are included. Uncheck the box
next to 'Contact all update sites during install to find required software'. Then click Next..

¥ Install m] X

Available Software
Check the items that you wish to install. \_D -

Work with: |jar:file:/(:,/Users/nxa‘l7459/0neDrive- NXP/Downloads/CodeWarrior/CW_MCU_11_1_Update1_191113.zip!/ v| Add...

Find more software by working with the "Available Software Sites" preferences.
pr text

Nane Version
00 MCU v11.1 Updates

00 MCU v11.1 Updates for DSC
7000 MCU v11.1 Updates for S12Z

Select All Deselect All 6 items selected
Details
Show only the latest versions of available software [[J Hide items that are already installed
Group items by category What is already installed?

[[] Show only software applicable to target environment
IDtontact all update sites during install to find required software:

® ’ Next > Finish Cancel

8. Follow the prompts until it completes the installation and prompts for restart of CodeWarrior
Development Studio. Click Yes and the tool will restart and the installation of the updates is complete.
¥ Software Updates X

You will need to restart CodeWarrior Development Studio for the changes to take
effect. Would you like to restart now?

mp ] =

Offline Install device support

After installation of Update 3 is complete you can install Service pack for devices — please make sure that you
downloaded corresponding file for offline installation and go to step 2 in offline installation section and use
Service Pack archive.
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Online Install CodeWarrior v11.1 + Update 3
1. Execute the online installer (CW_MCU_v11.1 b181224 PE.exe), following the prompts along the way.
Be sure to select DSC on the Choose Components menu.

¢ CodeWarrior Development Studio for Microcontrollers v11.1 5., — X

Choose Components -
Choose which features of CodeWarrior Development Studio for Microcontrollers w111« %
you want to install. -

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install: [] ColdFire/Sensors
|:| Kinetis

|:| Qorivva
[Js12z

[] soamsoa

Description

Space required: 1.5GB

2. Click Connect, then wait for the installation to complete downloading.

-+ CodeWarrior Development Studio for Microcontrollers w11.1 5., —

Installing s
Flease wait while CodeWarrior Development Studio for Microcontrollers wi1.1is being = %
installed, -

Downloading com. freescale.mcull_1.dsc.updatesite. zip

Show details

2024kB (1%:) of 204505kE @ 2024.0kB/s (1 minute remaining)

< Back Mext = Cancel
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3. When complete, launch CodeWarrior v11.1, then go to Help -> -> Install New Software...

¥ C/C++ - CodeWarrior Development Studio - m} X
File Edit Source Refactor Search Project MOQX Tools Processor Expert Run  Window Help
milhd K~ [Active) v @R F- E R WO Welcome
(7)  Help Contents i | B C/ce+
7 Search —

FZ) CodeWarrior Projects 53 = 0 % 8

— Dynamic Help

2= 1az‘ =] 4:5}3 File Name

- Key Assist... Ctrl+Shift+L

FileName Build Videos...

Tips and Tricks...

Cheat Sheets...

Check for Updates
| Install New Software...

Documentation

About CodeWarrior Development Studio

#3 Commander 2 ® Y =8

~ Project Creation - Se
[23 Import project @
¥ Import example project %
4y Import MCU executable file 5
-
5 MNew MCU project - M
+ Build/Debug \
LS & O [ Problems 51 Console B Y= 0O
; g f Oitems
Description Resource Path Location Type
Updates Available x
| Updates are available for your software.
@ B | Click to review and install updates.

| Set up Reminder options

£ |

4. Select “NXP MCU Eclipse Update Site - http://nxp.com/Igfiles/updates/Eclipse/MCU11_1/updatesite” in
the list of available update sites

¥ Install

Available Software
Check the items that you wish to install,

Work with:e MXP MCU Eclipse Update Site - http://n i H l Add... ]

DAwWAMCIUNMCU_Release ARM\Layout_Baselocation\eclipse - jarfile:CATempCW11\com freescale.mcull 1 kineti =
files/ D/ MCU/MCU_Release CF/ColdFireSite/ - metadata - jarfile: &\ TemphCW11hcom . freescale.mcull_1.coldfire

files/ D/ MCU/MCU_Release_DSC/DSCSite/ - metadata - jarfileCATemp\CW11\com.freescale.mecull _1.dsc.updat —
files/ D/ MCU/MCU_Release_E200,/E2005ite/ - metadata - jarfileCA\Temp\CW11\com.freescale.mecull 1.e200.upd| ||
files/ Dt/ wi/MICU/MCU_Release HCS/HCS5ite/ - metadata - jarfile: Ch\Tempt CW11\com.freescale.mcull_1.hos08_rs(if _

ites” preferences.

type filter tex

Mame

"

MNXP MCU Eclipse Update Site - http://nxp.com/lgfiles/updates/Eclipse/MCULL_1/updatesite
> [E]0m C files/ D/ MCU/MCU_Release 5127751251t/ - metadata - jarfile:ChATemphCWI11hcom.freescale.meull _1.512z.updal
> [C]000 D --Only Local Sites--

> [F 000 K
, Fo M

1 | ¢

5. Notice the Updates listed in the Install menu. Check the boxes for 'MCU v11.1 Updates' and 'MCU v11.1
Updates for DSC'. These updates are cumulative, so all previous updates are included. Uncheck the box

11
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next to 'Contact all update sites during install to find required software'. Then click Next..

B Install O *
Awailable Software
. ; . 3 b
Check the items that you wish to install. :)l__
Work with: | MXP MCU Eclipse Update Site - http://nxp.com/Igfiles/updates/Eclipse/MCU11_1/updatesite v| Add...

Find more software by working with the "Available Software Sites” preferences.

type gdter text
Na Version Q

v 00 MCU w111 Updates

] L MCU V111 update 11.1.3.202006191932
= MCU Wizard and Tools Plugins 11.1.0.F5L_b191024
00 MCU 11,1 Updates for DSC

] & CodeWarrior DSC Debugger 11.1.0.F5L_b2407
] & Documentation for DSC 11.1.3

[ & DSC Buildtools 1.09

[ 4 DSC v11.1 update 11.1.3.202007171335
7] & DSC Wizard, Debugger 1.0.11

Lk MCU w11.1 DSC Service Pack for DSC MC56F8300¢ 1.0.24

L MCU w11.1 DSC Service Pack for DSC MWCT1x13VLs 1.0.7

] 000 MCU w11.1 Updates for Qorivva
] 000 MCU w11.1 Updates for 5122
] 000 Qorivva Suppert

[] 000 S08/RS08 Support

W

Select All Deselect All 9 items selected
Details
Show only the latest versions of available software [JHide items that are already installed
Group items by category What is already installed?

[] Show only software applicable to target environment

[ Contact all update sites during install to find required software

@j * Next > Finish Cancel

Update 3 includes Service Packs for MC56F83xxx and MWCT1x13VLx.

In case of online scenario, you can get support for devices in the same dialog. Select Service Packs for
devices which you need to proceed with the Next action.

12
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B Install

Available Software
Check the items that you wish to install.

Work with:

NXP MCU Eclipse Update Site - http://nxp.com/Igfiles/updates/Eclipse/MCUT1_1/updatesite

v]

type filker text

MName

7000 Kinetis Support
CUw11.1 DSC Service Packs
MCU v11.1 DSC Service Pack for DSC MC36F8 1300
MCU v11.1 DSC Service Pack for DSC MC36F826xx
MCU v11.1 DSC Service Pack for DSC MWCTI011B
MCU v11.1 DSC Service Pack for DSC MWCT2xx3
CUw11.1 508 Service Packs
v [ 000 MCU w111 Updates

[t MCU 11,1 update

Select All Deselect All 9 items selected

Find more software by working with the "Available Software Sites” preferences.

Version

1.0.17
1.0.16
1.0.3
1.0.8

11.1.3.202006191932

O

[ ]
D =

Add...

Note: If the list you see is longer and you are experiencing some difficulty in locating the updates listed

above, then click on Window -> Preferences, then expand Install/Update and select 'Available Software

s

Sites'. Then uncheck all of the sites listed except "NXP MCU Eclipse Update Site", as shown below. Then

try 'Check for Updates' method again.

¥ Preferences

type filter text Awvailable Software Sites
General
CiCe- |t_\,rpe filter text
Coloring Editor
Freescale Licenses Name Location Enabled
Help (| \rﬂ F5L MCU Eclipse Update Site jarfile/C:/Users/nxal7453/0neDrive - NXP/Downloads/CodeW... Disabled
v Inst;ll_rUpdat.E Und ] =l NXP mMcU Eclipse Update Site http://nxp.com/Igfiles/updates/Eclipse/MCU11_1/updatesite Enabled
AUt_DIN::ItKS f:watess.t mE http://dev.eclipse.org/svnroot/dsdp/org.eclipse.tm.tcf/releases.. Disabled
r—— O \':] http://download.eclipse.org/maodeling/emf/updates/ Disabled
MQK Preferences P P 9 9 P
| \r:] http://download.eclipse.org/modeling/emft/updates/ Diszbled
Processor Expert P P 9 9 P
Remote Launch O \r',] http://download.eclipse.org/tm/updates/3.4 Disabled
Remote Systems (] \fu http://download.eclipse.org/tools/cdt/releases/helios Disabled
Run/Debug [l \r:] http://download.eclipse.org/tools/cdt/releases/indigo Disabled
Software Analysis O \':] http://gnuarmeclipse.sourceforge.net/updates Diszbled
Team [} \r:] http:/fwww.pemicro.com Disabled
Terminal mE http:/fwww.pemicro.com/PEPlugin Disabled
Trace Configurations
€ >
@

Add...
Edit
Remove
Reload
Dizable
Import...

Export...

Cancel

6. Follow the prompts until it completes the installation and prompts for restart of CodeWarrior Development
Studio. Click Yes and the tool will restart, and the installation of the updates is complete.
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HOWTO: Install CodeWarrior 11.1 Updates/Updates for DSC + Device Service packs

¥ Software Updates >

e ——
i3 e

You will need to restart CodeWarrior Development Studic for the changes to take
Y effect. Would you like to restart now?

Yes Mo

Install DSC compiler update only
1. Launch CodeWarrior 11.1, then go to Help -> Check For Updates

¥ C/C++ - CodeWarrior Development Studio - [m] x
File Edit Source Refactor Search Project MOX Tocls Processor Expert Run Window Help
F9~ s 7| lActive) v |8 ;’f g W v Welcome
() Help Contents 2 | g /e
;' Search
F@ Codewarior Projects 53 = 0 % Dynamic Hel = g8
_ - namic Help
= osE
- Key Assist... Ctrl+5Shift+L
~ Videos...
File Name Build e
Tips and Tricks...
Cheat Sheets...
» Check for Updates
nsia Ew 201 are.
Documentation
About CodeWarrior Development Studie
&3 Commander 22 = Y =08
+ Project Creation - Se
£¥g Import project @'
% Import example project &
fxg Import MCU executsblefile i
% New MCU project - Mi
= Build/Debug \
S & Bl problems 2 Console B Y= 8
; g F 0items
=
Description Resource Path Location Type
Updates Available x
[ Updates are available for your software. |
a o | Click to review and install updates. |
| Setup Reminder options
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HOWTO: Install CodeWarrior 11.1 Updates/Updates for DSC + Device Service packs

2. Select items Documentation for DSC and DSC Buildtools - Click Next.
P dovailable Updates

k the updates that you wish to install.

com.freescale. dsc buildtocls festure.group

gk MCU Wizarnd and Tools P'Iug:rk; 11.100F5L_b19102a -:qm.fr\crsulr.rm'u.ftaturc.grnup

Select All Dezedect A1

Dretanls

:?_}l * et » Fanish Cancel

Available Updates

Py
€ Verson Id
|k § Documentstion for D5C 11.0.1 cam.freescale.doc.dsc festure.group
£ §5 D5C Buildtools 108

Studio. Click Yes and the tool will restart and the installation of the updates is complete.

¥ Software Updates oy

You will need to restart CodeWarrior Development Studio for the changes to take
effect. Would you like to restart now?

mp = e

Follow the prompts until it completes the installation and prompts for restart of CodeWarrior Development
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